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The Code Blue® III Adult is an interactive educational system 
developed to assist a certified instructor. It is not a substitute for a 
comprehensive understanding of the subject matter and not intended 
for clinical decision making.
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End User License 
Agreement
This is a legal agreement between you, the end user, and Gaumard® Scientific Company, Inc. 
(“Gaumard”). This software is protected by copyright laws and remains the sole property of Gaumard. 
By installing the GaumardUI (the "Software") media, you agree to be bound by the terms of this 
agreement. If you do not agree to the terms of this agreement, promptly return the uninstalled media 
and accompanying items to Gaumard at the address indicated below.

1.  Grant of License. Gaumard hereby grants to you (an individual or institution) the right to install and 
activate the Software on one computer for use with one Interactive patient simulator system. The 
software may also be installed on any number of other computers at the same institution so that 
students may access the learning resources. One copy of the software may be made for backup 
purposes. You may not network this Software, or allow multiple users unless you purchased a multi-
user workstation license. Sharing this Software with other individuals or allowing other individuals 
to view the contents of this Software is in violation of this license.

2.  Copyright. The Software is owned by Gaumard and protected by United States copyright laws and 
international treaty provisions. Therefore, you must treat this Software like any other copyrighted 
material. You may not make this Software or copies thereof available in any manner or form or use, 
copy or transfer the Software, in whole or in part, except as provided herein.

3.  Other Restrictions. You may not rent or lease this Software to any other party. You may not alter, 
merge, modify, adapt, reverse engineer, decompile or disassemble the software, or disclose the 
contents of this Software to any other party.

4.  Electronic Transmission of Software. If you received the Software by electronic transmission or 
by Internet delivery, by installation of the Software, you acknowledge that you have read and 
understand this license agreement and agree to be bound by its terms and conditions.

5.  Term of Agreement. The term of this Agreement and the license granted to you pursuant hereto 
shall commence upon installation of this Software. This Agreement and the license granted herein 
may otherwise be terminated by Gaumard in the event that you are in breach of any provision 
of this Agree¬ment. In the event of termination, you agree to immediately return this Software, 
accompanying items, and any copies thereof to Gaumard.

6. LIMITED WARRANTY

(A) THE CD-ROM MEDIA (THE "MEDIA") WHICH CONTAINS THIS SOFTWARE IS WARRANTED, 
FOR A PERIOD OF 30 DAYS FROM THE DATE OF PURCHASE, TO BE FREE FROM DEFECTS IN 
MATERIAL AND WORKMANSHIP. ELECTRONIC TRANSMISSION IS WARRANTED TO BE FREE 
FROM DEFECTS AT THE MOMENT OF TRANSMISSION. YOUR SOLE AND EXCLUSIVE REMEDY, 
AND GAUMARD'S SOLE LIABILITY, IS TO REPLACE THE DEFECTIVE MEDIA OR TO REPEAT 
THE ELECTRONIC TRANSMISSION PROVIDED THAT YOU NOTIFY GAUMARD IN WRITING OF 
SUCH DEFECT OR DEFECTIVE TRANSMISSION AND RETURN THE DEFECTIVE MEDIA, IF ANY, 
DURING THE 30-DAY WARRANTY PERIOD.
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(B) EXCEPT AND TO THE EXTENT EXPRESSLY PROVIDED IN PARAGRAPH (A), THE SOFTWARE 
AND ACCOMPANYING WRITTEN MATERIALS ARE PROVIDED ON AN "AS IS" BASIS, WITHOUT 
ANY WARRANTIES OF ANY KIND, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES 
OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. NO ORAL OR WRITTEN 
INFORMATION OR ADVICE GIVEN BY GAUMARD, ITS DEALERS, DISTRIBUTORS, AGENTS OR 
EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS 
WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. GAUMARD 
DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE 
USE OR THE RESULTS OF USE, OF THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF 
CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE, AND THE ENTIRE 
RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IF 
THE SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU AND NOT GAUMARD OR ITS 
DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION OTHER THAN EXPRESSLY DESCRIBED 
ABOVE.

(C) NEITHER GAUMARD NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, 
PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, 
INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS 
OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND 
THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE SUCH PRODUCT OR RELATED 
TO THIS AGREEMENT EVEN IF GAUMARD HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. GAUMARD SHALL NOT BE LIABLE TO YOU FOR ANY INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES OR LOST PROFITS ARISING OUT OF OR 
RELATED TO THIS AGREEMENT OR YOUR USE OF THE SOFTWARE AND/OR THE RELATED 
DOCUMENTATION, EVEN IF GAUMARD HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. IN NO EVENT SHALL GAUMARD'S LIABILITY HERE UNDER, IF ANY, EXCEED THE 
PURCHASE PRICE PAID BY YOU FOR THE SOFTWARE.

ALL RIGHTS NOT EXPRESSLY GRANTED IN THIS LICENSE AGREEMENT ARE RESERVED BY 
GAUMARD.

ACKNOWLEDGMENT

BY INSTALLATION OF THIS SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ AND 
UNDERSTAND THE FOREGOING AND THAT YOU AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE 
STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL PROPOSED 
OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS 
BETWEEN THE PARTIES RELATING TO THE LICENSE DESCRIBED HEREIN.
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Care and Cautions
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Overall Warnings
Remember that damage caused by misuse 
is not covered by your warranty. It is critical 
to understand and comply with the following 
guidelines:

GENERAL

•  There are inherent dangers in the use of 
some medical devices. For simulations that 
incorporate electrical therapy of any kind, 
always know your equipment and follow the 
device manufacturers’ safety guidelines.

•  Never disconnect the communications 
module while the GIGA software is running. 
The software will halt, and the module may be 
damaged.

•  Do not wrap this or any other Gaumard 
product in newsprint.

•  Indelible marks made with ballpoint pens, ink 
or marker cannot be removed. 

•  Only use Gaumard’s provided simulated 
blood. Any other simulated blood containing 
sugar or any additive may cause blockage 
and/or interruption of the vasculature system.

WARNING

Vein tubing contains latex which may 
cause allergic reactions. Users allergic 
or sensitive to latex should avoid contact. 
Discontinue use of this product and seek 
medical attention if an allergic reaction 
occurs.

•  Replacement parts are available from 
Gaumard Scientific or from your Distributor.

OPERATING CONDITIONS

Operating the simulator outside these ranges 
may affect performance:

•  Operating temperature: 50°-95° F (10°-35° C).

•  Humidity: 5%-95% (non-condensing).

STORAGE CONDITIONS

•  Storage temperature: 32°-113° F (0°-45° C).

•  Humidity: 40%-60% (non-condensing).

•  Do not stack or store heavy materials on top 
of the carton. 

PROCEDURES

•  Do not attempt to intubate without lubricating 
the airway adjunct with mineral lubricant 
(provided). Failure to do so will make 
intubation very difficult and is likely to result 
in damage.

•  Mouth to mouth resuscitation without a 
barrier device is not recommended, as it will 
contaminate the airway. 

•  Treat the simulator with the same precautions 
that would be used with a real patient.

•  The use of needles larger than 23 gauge will 
reduce the lifetime of the lower arms’ skin and 
veins.

•  When the arm veins require replacement, 
contact Gaumard to arrange for a lower arm 
exchange. Refer to the “Consumables and 
Replacement Parts” section of this guide, and 
contact customer service for more information.

CLEANING

•  The simulator should be cleaned with a cloth 
dampened with diluted liquid dish washing 
soap. 

•  Remove all traces of any lubricant.

•  Do not clean with harsh abrasives.

•  Do not use povidone iodine on the simulator. 

•  Dry thoroughly. 

•  The simulator is “splash-proof” but not water-
proof. Do not submerge or allow water to 
enter the interior of the simulator. 

ELECTRICAL THERAPY

•  Defibrillation is only allowed on the large 
sternum and apex sites. NEVER deliver 
a shock to ECG electrode targets on the 
shoulders or waist. Doing so will not create a 
fire hazard, nor is there risk of shock to the 
provider, but internal damage in the simulator 
may result. This situation is considered 
improper use and is NOT covered by the 
simulator warranty. The system will require 
repair at our facility.

•  Always treat the simulator as a real patient.

ECG AND ELECTRICAL THERAPY 
CHECKLIST AND WARNINGS

•  Only deliver electrical therapy when the 
simulator is fully assembled, dry, and 
undamaged.

•  Make sure the defibrillation patches on the 
simulator are in good condition, including 
removing any and all gel residue on the 
defibrillation patches from previous use(s). 
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•  It is a good practice to remove gel residues 
after every use. Failure to do so will leave 
behind a film of electrode gel that hardens 
causing arcing and pitting.

•  Do not re-use the gel-adhesive pads. Do not 
leave them on for next day use.

•  Use hard paddles or wet-gel pads preferably. 

•  Avoid using solid-gel pads since they present 
higher risk of burning the simulator’s skin.

•  Gel pads have a shelf life. Make sure they are 
not expired to avoid arcing.

•  Make sure the simulator is not in contact with 
any electrically conductive surfaces.

•  Use the simulator only in a well-ventilated 
area, free of all flammable gases.

•  NEVER attempt to service or modify any of 
the electrical connections, especially those 
between conductive skin sites and the internal 
electronics. 

•  Discontinue use if any wires are found 
exposed with damaged insulation.

•  Real medical products, especially electrodes, 
sometimes use powerful adhesives that can 
be difficult to remove. A gentle, degreasing 
cleanser may be needed.

•  Electrode gel on the skin between any two 
electrode targets can become a pathway for 
electrical current, just as in real life. If this 
occurs, Adult’s skin can be burned.

•  Do not allow defibrillation pads to overlap ECG 
sites. Doing so may damage the simulator 
and cause arcing.

•  Should dark traces appear on the conductive 
patches due to gel residue or previous arcing, 
use a pencil eraser to remove the traces and 
then clean with alcohol. 

•  DO NOT SCRATCH the conductive patches 
with abrasive objects; doing so will cause 
irreversible damage to the conductive sites 
and subsequently cause arcing.
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Getting Started
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Overview
Your simulator is an advanced life support 
training simulator equipped with the following 
features:

AIRWAY

•  Oral and nasal intubation

•  Use an ET tube or LMA

•  Perform Sellick’s maneuver

•  Airway sounds

•  Sensors detect depth of intubation

•  Unilateral chest rise with right main stem 
intubation

•  Visible gastric inflation with esophageal 
intubation

APPEARANCE 

•  Color responds to hypoxic events and 
interventions (healthy, mild cyanosis, severe 
cyanosis)

•  Articulated neck, jaw, arms and legs

BREATHING

•  Spontaneous breathing

•  Breathing patterns

•  Bilateral lung expansion with realistic chest 
rise an fall

•  Left and right lung sounds synchronized with 
breathing

•  Accommodates assisted ventilation 

•  Ventilation is measured and logged

•  Gastric distension with excessive BVM 
ventilation

CIRCULATION

•  Conductive skin regions allow for ECG 
monitoring with real equipment

•  Heart sounds may be auscultated and are 
synchronized with ECG

•  Depth of chest compressions are measured 
and logged in cm or inches

•  Bilateral carotid and femoral pulses

•  Left side brachial and radial pulses

•  Blood pressure auscultation in left arm with 
modified BP cuff 

•  Korotkoff sounds audible between systolic 
and diastolic pressures

•  Oxygen saturation placement detection on 
the left index finger

•  Defibrillate and pace using real devices

•  Defibrillation snap connectors

SIMULATOR

•  Full size adult simulator

•  Realistic airway with tongue, vocal cords, 
trachea and esophagus

•  Preprogrammed speech responses

•  Ribcage

•  Intraosseous access at right tibia 

•  IV training on the right arm 

•  Intramuscular injection sites in deltoids and 
quadriceps for placement exercises

OTHER

•  Powerful yet intuitive user controller and 
interface software

INCLUDED ACCESSORIES

•  Multimedia laptop 

•  Genuine Windows® 7

•  USB communications module

•  Communication cable

See shipping manifest for an up to 
date equipment list.

Terminology
It is wise to spend a moment familiarizing 
yourself with some of the terminology that will 
be used to discuss simulation with the Code 
Blue III system.

FACILITATOR

The person conducting the simulation; an 
instructor or lab staff member.
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GIGA™

The Code Blue III Adult User Interface software 
application, used to control the simulator and 
evaluate care providers.

PALETTE ITEM

Any full or partial set of physiological parameters 
that have been grouped and saved together 
under a single name.

PROFILE

A unique configuration, including custom 
Palette, Scenarios, and options. Each Profile 
acts as a separate program, in that changes 
made to one profile have no effect on others.

PROVIDER

A person participating in the simulation as a 
healthcare provider.

SCENARIO

A saved sequence of physiological states, 
like a “playlist.” Scenarios provide a level of 
automation that unburdens the facilitator and 
allows standardized presentation of symptoms.

SCENARIO ITEM 

A Palette Item that is part of a scenario. Scenario 
Items may also represent a fixed delay period 
(“Wait”) or a pause (“Wait Indefinitely”).
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Equipment Set Up
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Simulator Set Up

SIMULATOR PLACEMENT

Prepare the simulation area prior unpacking 
the simulator. The simulator’s designated 
area should have ample space for multiple 
participants to move about freely. 

Remove the simulator from the blue case with 
the assistance of at least two persons. Avoid 
lifting the simulator by the arms as it could 
damage the shoulder joints. Rest the simulator 
on a patient table capable of supporting the 
weight of a real adult patient.

LEG ASSEMBLY

Follow the steps below to install the lower legs. 

Remove the legs when transporting 
Code Blue III Adult inside the protective 
case.

1.  Remove the fixed bolts from the knee joints 
using the hexagonal wrench included.

2.  Connect the red pulse line as shown below

3.  Position the lower legs and insert the knee 
joint bolt. Tuck any extra wire and the 
connector into the lower leg.

4.  Replace the bolt and use the two provided 
hexagonal wrenches to secure the knee bolt 
without over tightening.

WARNING

Do not over tighten the bolts

BATTERY

Code Blue III Adult is shipped with the internal 
battery disconnected. Connect the battery lead 
as part of the first install process.

Warning

Do not remove the chest skin.

To connect the internal battery leads:

1.  Locate the connectors on Code Blue III 
Adult’s left hand side.
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Computer Set Up

CONTROL COMPUTER

The simulator is controlled from a laptop 
computer and a USB communication module.

Refer to the laptop’s documentation for 
important information regarding use, charging, 
and care before continuing.

COMMUNICATION MODULE

The Code Blue III Adult is powered on via a hard 
wired connection within a minute of the GIGA 
software initializing. 

Outlined below are the steps for connecting the 
simulator to the control laptop.

Connect the communication cable (blue 
Ethernet cable provided) to the communications 
port located on the left side of the simulator.

Connect the communication cable to the USB 
communication module.

2.  Gently lift the left corner on the chest skin as 
shown and connect the battery clip.

3. Slide battery leads inside the cavity.

4. Secure the chest skin. Connect the simulator’s 
power charger.

Immediately after connecting the battery leads, 
Code Blue III Adult is on stand-by mode and 
ready to be initialized by the GIGA software.

BATTERY LIFE

Battery charge time is approximately four hours. 
The AC adapter’s status indicator light displays 
red when the battery is charging and green 
when the process is complete.

To display the battery level, the GIGA software 
must first establish a connection with the Code 
Blue III Adult. For more information about the 
battery indicator, refer to “Working with GIGA” 
section, page 25.

Warning

Do not store the simulator with a 
discharged battery. It is good practice to 
re-charge the battery at the end of every 
simulation session. In addition, re-
charged the battery at least once every 
2 months even if the simulator is not 
being used; permanent loss of capacity 
might occur because of self-discharge.
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2.  Connect the charger’s AC plug into the  
power outlet and the power adapter plug into 
the laptop power port.

3.  Connect the video cable to the video-out 
port on the laptop.

4.  Connect the video cable to the LCD monitor 
screen.

Lastly, connect the communication module to an 
available USB port on the laptop, then power up 
the laptop computer.

EXTENDED SCREEN VIRTUAL MONITOR 
(OPTIONAL)

The control computer utilizes an extended  
monitor to display the simulator’s vital signs 
Follow the steps below to connect the monitor 
screen to the laptop computer.

1.  Begin by locating the laptop’s power input 
and video output. The location of these ports 
may vary by computer model



20  |  User Guide  |  Equipment Set Up  |

VIRTUAL MONITOR PC SETUP

Refer to the manufacturer’s documentation 
included with the virtual monitor system 
components for important safety, installation, 
and start-up information before turning on the 
computer for the first time.

To setup the virtual monitor PC:

1.  Place the all-in-one PC within line of sight of 
the controlling computer

2.  Connect the power supply

3.  Connect the USB keyboard and mouse 
receiver

4.  Turn on the computer

VIRTUAL MONITOR WIRELESS 
CONNECTIVITY

The control PC and the all-in-one virtual monitor 
PC automatically establish a wireless link at 
startup. The wireless connection allows the 
Gaumard control software to transmit the vital 
signs information to the Gaumard Monitors 
software. 

To verify the wireless link between the two 
computers, click the wireless icon located on 
the task tray. The wireless network name is 
configured at the factory and may differ from 
the one seen below. To troubleshoot connection 
issues between the virtual monitor computer 
and the controlling tablet, please refer to the 
Appendix section, page 88 .

5.  Connect the AC cord plug to the power outlet 
and the other end to the monitor’s AC input.

6.  Turn on the laptop and the additional LCD 
monitor.

The GIGA will load and launch the Virtual 
Monitor application automatically. Vitals signs 
will display on the additional LCD monitor.

WARNING

Never disconnect the communication 
module while the GIGA software is 
running. Doing so can seriously damage 
the module.

If the extended monitor does not display an 
extended image of the home screen, navigate 
to the appendix for instructions.

CONTROL TABLET PC (OPTIONAL)

The tablet PC is preloaded with the GIGA control 
software used by the facilitator to initialize the 
simulator and control the vital signs.

Before turning on the computer for the first time, 
please review the documentation included with 
the product for important care and warning 
information.

ALL-IN ONE TOUCH VIRTUAL MONITOR 
PC (OPTIONAL)

The All-in-one touch Virtual Monitors PC allows 
Gaumard Monitors software displays simulator’s 
vital signs in real time. 
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WIRELESS COMMUNICATION MODULE 
(OPTIONAL)

Code Blue III Adult has the optional feature 
to be powered on via wireless connection. 
This would eliminate the need to connect the 
communication cable to the simulator for it to 
function. 

GAUMARD MONITORS

After the wireless connection is established, 
double click or tap the Gaumard Monitors icon 
to start the vital signs software. 

The Gaumard Monitors software is now ready to 
receive the vital signs information generated by 
the GIGA control software.

For more information about the Gaumard 
Monitors , please refer to the “Working with 
GIGA” section, page 28.
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Working with GIGA™
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Initializing the 
Simulator
After reading the Care and Cautions section of 
the guide, double click the GIGA™ icon located 
on the laptop’s home screen to start the simulator.

The simulator selection menu is shown. Select 
Code Blue III Adult and click “Start”.

The software activates the simulator within 1 
minute after clicking the start button. When the 
GIGA is not active, the simulator is in stand-by. 
To address connection and startup issues, go to 
the Appendix section.

EXTENDED DESKTOP MONITOR 
(OPTIONAL)

The simulator’s vital signs are automatically 
displayed on the extended desktop monitor 
when the GIGA software is started. If no image 
is shown on the extended screen, go to the 
Appendix section to find information on how to 
enable the extended monitor.

PROFILES AND OPERATING MODES

After the startup screen, the profile selection 
menu is displayed.

A profile is a unique configuration of customized 
Palettes, Scenarios, and Options. Each profile 
functions independently, in that changes made 
to one profile have no effect on the others. The 
available profiles are: Default and Quick Start 
HAL.

After selecting a profile, click “Load” to continue.

The Manual mode includes the following profiles:

DEFAULT PROFILE

The default profile is a convenient starting point 
that can be customized to fit a particular simulation 
objective. It Includes one preprogrammed palette 
with healthy vital signs

QUICK START HAL

When first starting out with the Code Blue III Adult, 
it is recommended that you use the Quick Start 
HAL profile, which was created in conjunction 
with experienced healthcare instructors and 
working medical professionals.

The Quick Start HAL profile has applicable 
Palettes that are useful for simulating common 
medical emergencies. For many applications, it 
serves a convenient starting point that can be 
customized to fit most simulation objectives. It 
Includes ten scenarios

CREATING A NEW PROFILE 

Profiles store palette, scenario, and option 
settings independently; changes made to one 
profile have no effect on the others. Below are 
some examples on how profiles are used.

•  Assign one profile to each user of your 
Gaumard simulator system

•  Use profiles to organize and protect palettes 
and scenarios

•  Create a profile dedicated to a specific 
academic course taught by multiple instructors
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•  Devote an entire profile to one particular 
subject area, or even one particular scenario

To create a new profile, click “New Profile”.

Enter a name for the new profile followed by a 
description.

To include scenarios and palettes from other 
profiles, click the applicable check box. For 
security, enable PIN protection, which will require 
a user to enter a four-digit key before loading the 
protected profile.

Lastly, click “Create” to save the new profile.

To access the Profiles dialog box at any time, 
select Profiles, from the File drop-down menu:

GIGA™ Interface
The GIGA software is used control the simulator, 
monitor the vital signs, and evaluate the provider’s 
performance. The simulation technician or 
instructor carrying out the simulation operates 
the GIGA software

The GIGA control elements and scenario 
programming procedures are consistent 
throughout the Gaumard family of middle and 
high fidelity simulators. Some software controls 
and features covered in this guide may be 
hidden depending on the simulator’s hardware 
configuration and optional upgrades.
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CONNECTION STATUS

Full bars indicate excellent communication 
between the computer and the simulator (i.e., 
normal operation).

The indicator is clear when no attempts to 
communicate with the simulator are being made; 
for example when the communication module is 
not connected to the computer.

After the communication is established the 
simulator will take 60 seconds approximately to 
start breathing.

BATTERY INDICATOR

The battery status indicator progresses as the 
battery in the simulator is used. The exclamation 
mark indicator is shown when there is no 
communication and battery information cannot 
be retrieved.

When the battery icon is depleted, the simulator is 
set to STAND-BY mode automatically to protect 
some of the simulator’s internal components. 
Simulator will not initialize until connected to the 
charger or the battery is replaced with a fully 
charged spare. 

Internal battery duration is approximately 6 hours

WARNING

Turn Simulator OFF before replacing the 
battery. Failure to do so could result in serious 
damage to the system.

SESSION CLOCK

The session timer allows the facilitator to 
maintain a chronological record for individual 
simulation sessions. The session timer can be 
reset from the file menu when a new simulation 
session begins, or by clicking the session time 
icon and then Reset Session Clock. Events 
during the simulation are logged in accordance 
to the session time.

POWER/STAND-BY BUTTON

The standby button is located on the bottom right 
corner of the GIGA software. Use the stand-by 
feature to conserve battery during lectures.
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CHANGING VITAL SIGNS

To adjust numerical values click the slider control. 
(e.g. heart rate, blood pressure, respiratory rate, 
etc.).

Alternatively, use the keyboard for manual entry 
and click the green checkmark to confirm the 
change. 

To change patterns, sounds, and rhythms, click 
on the specific control to display the library (e.g. 
EKG rhythms, heart and lung sounds,respiratory 
patterns, etc.)

STATUS/DETAILS CONTROLS

The Status/Details panel is used to monitor and 
control the simulator’s vital signs. The individual 
parameter controls displayed on the details tab 
provide the simplest method for controlling the 
simulator’s vital signs, sounds, and features.

The Status/Details tab displays the vital signs 
controls in a list format.

SYSTEMS LIST VIEW

The vital signs controls are divided into separate 
categories. Click through the categories to view 
the controls available for the current simulator 
configuration.
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Vital sign parameters can be edited or removed 
using the edit and remove parameter tabs

Enable the “instant apply” option and click the 
control to change the vital sign to a new value 
without the need to use “Apply” panel. Vital signs 
undergoing change blink yellow.

CREATING PALETTE ITEMS

A palette item stores one or more vital sign 
settings into a single loadable object. Use a 
palette item to update a set of vital signs quickly. 
For example, one palette item can be created to 
update all the cardiac parameters to a healthy 
state. 

To create a new palette item, set the values 
for the desired vital signs parameters using the 
details controls and click “Save”.

Enter a name for the palette, a description, and 
choose color code. Click “Save” to create the 

Click the slider control below the sound library to 
adjust the volume of the sounds.

APPLYING CHANGES

No changes will be made to the simulator’s 
condition until the new settings are submitted 
using the “Apply” panel.

After the list of changes is created, click “NOW” 
to update the vital signs instantly. Alternatively, 
click a trending timer to update numerical vital 
sign parameters (e.g. heart rate, blood pressure) 
gradually.
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Virtual monitor
The interactive virtual monitor tab (VM) displays 
the patient’s vital signs information in real time. 
The waveform and numerical parameters are 
interactive, and the layout is fully customizable. 
If the VM tab is not displayed by default, go to 
Menu subsection to activate the virtual monitor 
add-on.

WAVEFORM MENU

Click on the waveform name to access the 
options or change the waveform type.

new palette Item. Palette items are stored in the 
active profile.

When the palette is needed, click the Load button 
to select the palette from the library.

Select the palette item from the “Load Palette 
Item” menu and click “Load”

Click the apply option to submit the changes.
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3.  The new lead information is now displayed.

NUMERIC MENU

Click the numeric menu to access the numerical 
parameter options. To change the type of 
numerical parameter displayed, click the numeric 
menu and select “close”.

Click the empty numerical menu and select the 
new parameter type.

CHANGING VITAL SIGNS

Vital signs can be adjusted directly from the 
virtual monitor tab. First, Double click the vital 
sign parameter to access the floating control 
window. Then, adjust the parameter to the new 
value and submit the changes using the Apply 
NOW or trending option.

•  Freeze- Click freeze to pause a waveform 
reading. To unfreeze the selection, click the 
waveform menu and select Go.

•  Time- Click on the time option to change the 
length of the ECG waveform. The options 
available are 5 seconds, 10 seconds, 15 
seconds and 20 seconds.

•  Display- Click on the display menu to edit 
the wave form color, amplitude, intensity and 
scroll direction.

CHANGING THE WAVEFORM TYPE

The types of available waveforms are Pulse-
Oximetry, Arterial BP, and Respiration.

1.  To change which waveform is displayed on 
the ECG graph, begin by clicking the ECG 
icon then selecting “close”.

2.  Click the waveform menu box and choose either 
the type of wave to be displayed or the ECG 
lead.
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Open the “File Sharing” control from the icon or 
from the Menu/Monitors/File Sharing

The list of files stored on the Gaumard_UI folder 
available for sharing is displayed on the left 
panel. To share a file, select the file from the left 
panel and click “Send”.

Enter a context name on the pop-up menu and 
click “OK” to share.

NONINVASIVE BLOOD PRESSURE

By default, the NIBP parameter does not update 
automatically. Click the NIBP menu and select 
“Stat” to refresh the reading. Alternatively, set 
a refresh interval to automate the stat process 
periodically. 

File Sharing
FILE SHARING

The file sharing menu allows the facilitator to send 
images, audio, and text files to the virtual monitor 
screen. Use the file sharing feature to fulfill file 
requests by the provider during simulation.

The files used for sharing are stored in the 
control PC. Before the simulation begins, add 
mock image (.jpg, .bmp) or text files (.txt) into the 
Gaumard_UI folder located on the home screen 
of the control computer.
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To discontinue sharing the file, select the file from 
the file sharing menu and click “Recall”

Palettes
The Palette page appears identical in both the 
manual and automatic mode. Each item on 
the Palette represents a complete or partial 
physiological state. It displays all of the Palette 
Items in the active profile. Each profile has its 
own separately customized Palette. Recall that 
you can create Palette Items using the Details 
page.

Apply Palette Items using the buttons at the 
bottom of the page, just as changes to Simulator’s 
condition are applied on the Details list. 

Editing existing Palette Items is simply a matter of 
selecting the item you wish to modify and clicking 
the Edit button. You will be taken automatically to 
the Details list, and the settings that comprise the 
selected Palette Item will be displayed. Change 
them as desired, and click the “Save as Palette 
Item” button.

Many of the functions related to Palette Items 
are also available by clicking the second mouse 
button (usually the right button) while the pointer 
is positioned over an Item. Note, when using the 
tablet computer, this is best done by holding the 
stylus button while tapping the screen.

Lineal Scenarios
Scenarios automate the vital sign changes, 
responses, and software actions required to 
carry out a complete simulation exercise. GIGA 

Files currently shared are listed on the “Shared 
Files” list.

A yellow notification icon is displayed on the 
patient menu at the top left of the virtual monitor 
screen. The icon notifies the provider that a file is 
available for viewing. Click the patient menu and 
select the file open it.

The x-ray file is now open on the virtual monitor 
computer.
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SCENARIO POSITION INDICATOR

An unfilled triangle means 
that the scenario is stopped. 
When the Play button is 
clicked, the item being pointed 
by the indicator is played.

A rapidly blinking triangle 
means that the scenario is 
playing the item to which the 
indicator is pointing.

A slowly blinking triangle 
means that the scenario is 
paused at the item to which 
the indicator is pointing.

SCENARIO PLAYER CONTROLS

Plays the item to which the 
scenario position indicator is 
pointing. This button has two 
states: play or pause.

Pauses the scenario. This 
state of the play button is only 
active when the scenario is 
playing. It is disabled when 
a ‘Wait indefinitely’ item is 
playing because in such 
case the scenario is already 
paused.

The Stop button has two 
behaviors depending on 
when it is clicked. When 
clicked once, the Stop button 
halts the scenario at the end 
of the item currently playing. 
When clicked a second 
time, the scenario is stopped 
immediately. For example, if 
the item currently playing has 
a transition of 1:00 minute and 
the Stop button is pressed 
when it has 0:10 seconds left, 
the scenario will be halted 
at the end of the transition 
(i.e., in 10 seconds). If the 
Stop button is clicked again 
within those remaining 10 
seconds, the scenario stops 
immediately.

includes several preprogrammed scenario based 
simulation exercises in the “Quick Start Profile”.

To use a preprogrammed scenario go to the 
Scenario tab and click “Load Scenario”.

LINEAR SCENARIO OVERVIEW

A linear scenario is a playlist of vital signs palette 
items played back in succession.

During the scenario, each vital signs palette 
updates the patient’s vital signs. The palette’s 
transition time trends the increase or decrease 
of numerical parameters (e.g. Heart rate, blood 
pressure) over seconds or minutes. In the figure 
below for example, the vital signs palette “Healthy 
Resting” is programmed with a transition time of 
2 minutes. When the scenario reaches “Healthy 
Resting”, it will take 2 minutes for the vital signs 
to trend from the previous state to the values 
programmed within the palette.

Wait palettes do not update or change vital 
signs. Instead, wait palettes give the participant 
time to perform an action; this may be treatment 
in response to a complication or performing a 
standard assessment.

SCENARIO CONTROLS

Scenarios are controlled from the buttons at the 
bottom of the tab. The scenario plays palette 
items in much the same way a music player 
plays songs. Intuitively, the facilitator can play, 
stop, pause, skip, or repeat items as appropriate.

The Scenario Position Indicator points to the 
current item and shows the current status of the 
scenario. The following paragraphs describe in 
detail the behavior of each button and indicator.
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•  Modify and edit palettes

•  Save the scenario

CREATING PALETTE ITEMS

1.  First, create the palette items that you will use 
in your scenario. Use the Status/Details to 
change the controls that best describe the 
condition you are trying to simulate. Not every 
field has to be populated in order to save a 
palette item.

2.  Save your palette(s) by clicking on the “Save 
Palette” button on the upper right side of 
the page. The “Save As Palette Item” dialog 
box is now displayed. Assign a name to the 
Palette Item and specify a brief description. 
Also, select a color that represents the 
palette’s condition: green for healthy, red for 
critical, yellow for care required, and blue for 
other. Click Save.

The Next button advances the 
indicator to the next item on 
the scenario regardless if the 
scenario is playing, paused, 
or stopped. It can also be 
used to move the indicator to 
select an item before playing 
it.

Similar to the Next button, the 
Previous button returns the 
indicator to the previous item 
in the scenario.

The Reset button stops the 
scenario immediately and 
returns the indicator to the 
first item in the scenario.

SCENARIO QUICK LAUNCH

Use the scenario Quick Launch tab to start a 
scenario with a single click. 

The Quick Launch tab displays all of the 
scenarios saved in the active profile.

CREATING NEW LINEAL SCENARIO

The general process of creating a new linear 
scenario is the following:

•  Create a vital sign palette item for each state 
in the scenario

•  Add the vital signs palettes and wait times to 
the scenario

•  Play the scenario
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the vital signs until the “next item” button is 
clicked from the playback controls.

7.  The wait palette item is now added. 

8.  Also add “Time Lapse” to set a real time for the 
scenario. For example, applying a medication 
might take 2 and half hours to have the effect 
on the patient. So by adding this time lapse 
the real time can be reflected in the scenario 
but it will happen in 10 seconds

9.  Add more palette items and then use the 
“Selected Item” menu to make any changes.

10.  Click “Save Scenario” to store the scenario 
in the current profile for later use.

3.  After creating all the palettes, go to the 
Scenario tab and click on the “Add to 
Scenario” button.

4.  Select a single palette or enable Multi to 
select Select a single palette or enable Multi 
to select multiple palettes at the same time. 
Specify a transition time for the palette and 
click “Add”.

5.  Repeat step 4 to add more palettes, labor 
scenarios, wait times, speech, monitor 
sensors, files, and labs.

6.  A “Wait” item maintains vital signs values 
steady for the transition time allotted. Insert a 
“wait” item to give the provider time to perform 
an action or an assessment. For example, 
auscultating blood pressure or gathering 
general information about the patient. 
Alternatively, add “Wait Indefinitely” to hold 
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information making files available refer “File 
Sharing” section. To create a new lab report, 
refer to “Lab” sections.

Select the sensors to be “ON” for the scenario

AUTO RESPONSES

The scenario auto-response settings move 
the scenario to the next palette when electrical 
therapy is detected. Electrical therapy can 
be applied by the facilitator via Virtual Shock 
panel or by the care provider using real medical 
equipment if the simulator supports it.

11.  Type in a name and a description for the new 
scenario and click Save.

ADDITIONAL SCENARIO FEATURES

Incorporate the following features into a scenario 
for added realism.

•  Auto responses – move onto the next palette 
item automatically when virtual electric 
therapy is detected

•  File sharing lab reports, and monitor sensors – 
Send files and lab reports to the virtual monitor 
computer, and enable monitor sensors

•  Speech – add phrases or custom speech

SPEECH

Add realism to a scenario by integrating 
automated speech phrases. Click the Add to 
scenario button and select Speech. Then, select 
the type of speech and phrase using the menu.

FILE SHARING, LAB REPORTS, AND 
MONITOR SENSORS

The scenario can also automate the distribution 
of shared files, labs and monitor sensors. Click 
“Add to scenario”, and then use the “File”, “Lab” 
,and “Monitor Sensors” tabs to select from 
available documents and sensors. For more 
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Auto-responses advance to the next palette 
if the virtual shock is applied while a “wait 
indefinitely” palette is playing and the heart 
rhythm is “shockable”.

The three response options are defined below:

•  Off - The scenario does not respond to the 
electric therapy.

•  Prompt - The software detects the electrical 
therapy and prompts the user for approval 
before advancing to the next palette.

•  Auto – Advances to the next palette 
automatically only if the electrical therapy 
meets the threshold specified

Branching 
Scenarios
Unlike linear scenarios, which move from 
one palette to the next, the trajectory of a 
branching scenario can change in response to 
the participant’s actions. Click the “Branching 
scenario” tab to access the branching scenario 
window.

BRANCHING SCENARIO SCREEN

Use the panel buttons to clear, load, and save 
new scenarios, or to switch from branching to 
linear scenarios. Click “Load Scenario” to access 

the preprogrammed branched scenarios in the 
current profile.

CREATING A NEW BRANCHING 
SCENARIO

The process of creating a new branching 
scenario is the following:

•  Add nodes 

•  Add palettes or scenarios to each node

•  Add paths to nodes that require provider 
action

•  Create key events to alter the progress and 
trajectory of the nodes within the scenario

ADDING NODES

A branching scenario will consist of several 
“Nodes”. Each node is pre-configured to run a 
scenario or a series of palettes. The facilitator 
will then activate key events that will alter the 
trajectory of the nodes. 

1.  To begin, click Add node near the top of the 
window.

2.  To edit the node name and description, click the 
node’s identifier number button. Click Save to 
apply changes.

In this example, the following nodes will be 
created: [1] Start Bradycardia, [2] Deteriorate, [3] 
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Interventions, and [4] Atropine, [5] Epinephrine, 
[6] Dopamine and [8] Pace as possible responses.

ADDING PALETTES OR SCENARIOS TO 
A NODE

Configure each node with a set of palettes or 
scenarios.

Click Add Item to add specific palette items or 
Add Scenario to add full scenarios to this node. 
Repeat the process and add palettes to the rest 
of the nodes.

Add more nodes each with palette items to 
simulate every stage in the scenario. In this 
example, several nodes simulate the effects 
of medications that maybe administered to 
the patient by the provider. The first two nodes 
simulate the complication [1] Start Bradycardia, 
[2] Deteriorate. The following nodes: [3] 
Interventions, [4] Atropine, [5] Epinephrine, 
[6] Dopamine and [7] Pace are activated only 
when the provider administers the applicable 
medication or electrical therapy. Each node is 

programmed with palettes that simulate the 
effect described.

ADDING PATHS

A path refers to the trajectory from one node to 
another after the last palette in a node expires. 

1.  Click on the time limit icon to modify the “go to” 
point for the default path. After the last palette 
expires, the scenario will move on to the node 
as indicated by the arrow.

2.  Configure the countdown timer and the “go to” 
point for the default path. Click ok to save.
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3.  Node 1 is now configured to continue to Node 
2 as indicated by the path’s “go to” point.

KEY EVENTS

Key events allow the facilitator to alter the 
trajectory of a branched scenario. This is done 
by assigning multiple paths to a single node, 
then selecting one of the paths when the provider 
completes a desired task. To add a key event to 
a node:

1.   Click the Add path button, then the edit button 
located on the right.

2.  Use the Edit Path window to name, rename, 
sort and create key events. 

KEY EVENTS MENU

A key event is the action expected by the 
participant. The Key Event Menu includes 
Custom, Electrical Therapy, CPR, and Airway. 

Custom tab allows to type a name for the event 
and then click “Add”.

The remaining key event tabs like Electrical 
Therapy, CPR, and Airway, have a drop down 
menu to select the different options.

The Electrical Therapy key event includes:

•  Defibrillation Shock

•  Cardioversion Shock

•  Non-Sync Shock

•  External Pacing

Select one of the options, then, set the parameters 
for response to either joules or number of shocks 
and click “Add”

The CPR key event includes:

•  Correct Compressions

•  Correct Ventilations

•  Correct  Compressions and Ventilations.
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The key event is now programmed to move the 
scenario to node 8 if pacing is detected.

Labs
Use the Lab tab to create mock laboratory tests 
results to aid the participants during simulation. 
In addition, create new laboratory templates to 
supplement different types of scenarios. Once a 
laboratory report is created, send the file to the 
virtual monitor screen for the provider to access 
during the exercise. 

PREPARING A LAB REPORT

To create a new lab report with mock test results:

1.  Click “Create a New Lab Report” on the right 
panel.

The “Edit Lab Report” window is displayed.

Select one of the options, then set the amount of 
cycles and click “Add”.

The Airway key event includes:

•  Endotracheal Intubation

•  Mainstem Intubation

•  Endotracheal Extubation

Select one of the options, then click “Add”.

After the event is added to the Key Events list, 
assign the node that this action will move the 
scenario to, using the “Go to” menu. Click “OK” 
to save changes.

In the figure below, node 2 is configured with 
four alternate paths. Once the provider performs 
any one of the actions listed as key events, 
checkmark the key event to activate the alternate 
path.
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5.  Click “Save” to create the lab report.

The newly created lab report is now listed in the 
“Lab Reports” section. Sort lab reports by name, 
template, description, or color tag.

6.  Click “Preview” to review the final lab report.

The preview window displays the test results how 
the provider will see them on the virtual monitor 
screen. If the computer is connected to a printer, 
click PRINT to create a hard copy.

SEND TO MONITOR

Send the completed lab report to the virtual 
monitor screen to assist the care provider. 

2.  Select a “Lab Template” from the drop down 
menu.

3.  Enter a report name, a report time, and a 
description. In addition, select a color tag for 
the lab report on the right panel. Color tags 
aid the sorting of lab reports on the report list 
window.

4.  Enter the test results in the “Value” column. 
Include any comments associated with the 
test performed.

Lab result values for each of the 
preprogrammed scenarios in the Quick 
Start HAL profile are included in the HAL 
Workbook.
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panel to remove the lab report items from the 
Gaumard Monitors menu. 

An editable copy of the lab report is stored inside 
the Gaumard_UI folder on the computer’s home 
screen. Go to page 30 for information on how 
to access other files from the Gaumard Monitor 
screen.

CREATING A LAB TEMPLATE

Build new lab templates to supplement new 
scenarios.

To create a new laboratory test template: 

1.  Navigate to the bottom of the tab and click 
“New Template”.

The “Edit Lab Results Template” window is 
displayed.

2.  Enter a name for the new template followed by 
a description.

To transfer the lab report to the virtual monitor 
screen:

1.  First, select the report from the lab reports list.

2.  Click “Send to Monitor” button to transfer the lab 
report to the virtual monitor.

3.  An exclamation icon notifies the provider a file is 
ready for access on the Gaumard Monitors. 
Instruct the participant to click the patient 
menu drop down and select the lab report.

4.  The lab report opens using the system’s default 
application.

5.  The letter Y represents a shared document. 
Click the “Stop Sharing button” on the right 
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8.  Repeat the process to add more tests and 
categories. Click “Save” to create the new lab 
template.

The new template is listed on the “Lab Template” 
section at the bottom of the Lab tab. Use the 
buttons on the left panel to edit or delete lab 
templates.

Speech
PRERECORDED SOUNDS

Select the Speech tab to command the simulator 
to speak aloud. The collection of speech and 
other sounds covers a wide range scenarios.

Click the phrase button to have the simulator 
speak the phrase aloud. Alternatively, program 
the phrases into a scenario to have the simulator 

3.  Create categories to group a series of tests 
in a lab report. Click “Add” to create a new 
category.

4.  Enter the name of the category and click “OK”.

5.  Click “add” on the “Single Entry” menu to 
create a new test under the current category. 

6.  Enter the name of the test, the unit, and 
decimal precision.

7.  Enter a “Normal Range” as a reference for 
the provider. The normal range is visible on 
the lab report. The “Allowed Range” restricts 
the minimum and maximum value that can be 
entered in a test result. Click “OK” to add the 
new test.
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Open this window when your students or providers 
are ready to start performing compressions and/
or ventilations

TESTING

The test mode provides compression and 
ventilation feedback in real time without audible 
cues.

To begin, press the Start button. Perform 
compressions and ventilations to obtain:

•  Graphical representation of compressions and 
ventilations: the ventilations are represented 
by the blue segment and the compressions by 
the red segment.

speak automatically, for more information, refer 
to “Scenario” section.

CPR
GIGA features a CPR performance evaluator 
and trainer. Click the CPR icon on the vertical 
menu bar to open the CPR window.

This tool allows the instructor to get real-time 
feedback on the current compressions and 
ventilations being done by the providers. Also, it 
will register real or virtual electrical therapy.

It is important to know that the chest 
compressions will only give feedback to 
the instructor if the blood pressure is below 
60, and ventilations will only be reported if 
the respiration rate is set to zero.
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•  Comp/Vent Cycles and CPR Time

Comp/Vent Cycles value shows the number of 
cycles performed. The CPR Time shows the total 
time of the CPR activity.

COACH

The coach mode is enabled when the Coach 
button is pressed.

The coach mode generates visual and audible 
cues of the compression to ventilation ratio 
programmed in the Options menu. A high-pitched 
beep, signals the care provider to perform 
compressions. A low pitched-beep, signals the 
provider to perform ventilations. If the provider 
performs CPR at a correct rate, the beep signals 
volume will decrease. If the rate is out of range, 
the beep signals volume will increase again.

Compression and ventilation data is displayed 
in the log window as CPR is performed by the 
provider

REPORT

Access the report after completing a CPR 
session. This window displays a summary of the 
most important parameters during CPR training. 
To access the report, press the Open Report 

•  Compression rate and depth indicators:

The compression rate and depth indicators 
are located to the left of the CPR window. The 
indicator’s fill color changes between the following 
states:

1.  Yellow: compression was too shallow.

2.  Green: compression was performed correctly.

3.  Red: compression was too deep.

•  Ventilation volume and duration indicators

The ventilation volume and duration indicators 
are located to the right of the CPR window. The 
indicator’s fill color changes between the following 
states:

1.  Yellow: Ventilation was too weak

2.  Green: Ventilation was performed correctly

3.  Red: Ventilation was too strong

•  Compression/Ventilation Ratio and No-Flow 
Time

Compression/Ventilation ratio is located in the 
center of the CPR window. The No-Flow Time 
shows the time without performing compressions.
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Click the lightning icon to open the “Shock/Pace” 
panel.

Provider Actions
Use the Provider Actions tab to track actions 
performed by the provider manually. Each option 
on the Provider menu generates a time stamped 
entry in the text log below. 

SESSION INFORMATION

Enter the session tile information and the name 
of the facilitator at the start of the session. The 
information is included in the final log report.

TEAM LOGGING

The team logging feature is used to track the 
individual actions of up to six providers manually. 
The feature records the name of the provider with 
the action as an event entry in the log.

To add a new provider to the Provider Actions” 
window:

button. Note that this button is disabled until the 
Stop button has been pressed.

The report will show the session details and 
objectives, and the session results.

Print or save the report data by pressing the print 
button located on the top right of the window.

Shock/Pace Panel
The shock panel is a floating window used to 
apply electrical therapy to the patient virtually. Go 
to Scenarios section for more information on how 
to work with the “auto responses” feature and the 
virtual shock panel.
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the provider as active and track the actions 
individually.

Click the appropriate option to track the action. 
For example, if the provider assesses the patient’s 
responsiveness by requesting them to open their 
eyes, click the “Assess responsiveness” button 
and select “Open your eyes”.

The following log entry is generated with the 
name of the active provider who performed the 
action:

Click the “Team” button to deactivate the active 
provider and return to general logging. Right 
click the provider button to delete or rename a 
provider.

1.  Click Add” button to add a new provider.

2.  Enter the provider’s name and select a color 
tag. Click OK to save the provider.

3.  The provider is now added to the log tab. 
Repeat the steps to add up to six different 
providers.

TRACKING PROVIDER ACTIONS

Provider actions can be tracked as a team or 
individually. Click the provider’s name to set 
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4.  Enter a description for the possible action 
and click + to add. Repeat the process to add 
several actions. 

5.  Click OK to save

The new action is listed in the airway category.

CREATING NEW PROVIDER ACTION 
BUTTONS

Create new clickable provider action buttons to 
expand the library of actions. To add a new action 
to an existing category:

1.  Click the + button on the category

2.  The category menu is displayed

3.  Enter the name of the action and select the type 
of action
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ADDING NOTES

Enter notes into the “add to log” field to record 
notes manually. The information is categorized in 
the log as “NOTE”.

CREATING A NEW SESSION LOG

The log event “time stamps” reference the GIGA 
session clock. At the start of a new simulation 
exercise, click File>New Session to reset the 
session clock 00:00:00, reset any vital parameters 
settings, and clear all the event entries.

SAVING THE LOG INFORMATION

The log information is recorded in a rich text 
format. Export the log information to save a 
detailed history of the events that occurred during 
the session. 

To save the session log report as a text file:

1.  Click FILE>Save report

2.  Enter a name for the report

3.  Select the desired name and path, and click 
“Save”.

Evaluation Form
The evaluation tool assists facilitators in reporting 
and assessing provider interaction using a 
questionnaire form. A completed evaluation 

Event Log
The event log records a time stamped entry of 
events that occur during the simulation session. 
It addition, every individual entry records a 
snapshot of the vital signs parameters when the 
event occurred. The text log records the following 
events:

•  Vital sign changes applied manually or made 
by scenario

•  Events detected by onboard sensors (e.g. 
intubation sensor, defibrillation sites)

•  Preprogrammed speech phrases

•  Satisfactory or unsatisfactory evaluation 

•  Facilitator notes

Select an entry from the list and right click to view 
additional options.

Select “patient vital signs” options to view a 
snapshot of the vital signs values when the event 
occurred.
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Complete the form by answering each question.

Click “Print” at the top right corner of the screen 
once the evaluation is completed.

Select the Microsoft XPS Document writer to 
save the finished evaluation as digital document. 
Click “Print” to save the digital copy in the system.

form can then be stored as a digital document or 
printed for distribution.

USING BUILT-IN EVALUATION FORM 
TEMPLATES

Several preprogrammed evaluation templates 
included in the GIGA software. Each template 
includes a set of multiple-choice questions, fill in 
the blank, and true or false questions for a variety 
of scenarios. 

Select an evaluation template from the “Load 
template” drop down to begin.

Enter the name of the facilitator administering the 
evaluation in On-Site Reviewer field.
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Select the printer device from the list box and 
click print.

It is recommended that documents be first saved 
as XPS files before being printed into hard 
copies.

CREATING NEW EVALUATION 
TEMPLATES

Create new evaluation templates for new 
scenarios using the edit mode. To enter the edit 
mode, toggle the “Go To button” located on the 
top right of the evaluation form window.

Enter a name for the new evaluation template in 
the “Evaluation Name” field.

Click “Add” on the Category menu.

Enter a name for the evaluation and click “Save”.

PRINTING AN EVALUATION

If the PC is connected to a printer, select and 
open the evaluation document saved in the 
previous step.

Navigate to the XPS Viewer file menu and select 
“Print”.
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Repeat the previous steps to add more categories, 
questions, and multiple-choice options.

After the evaluation template design is complete, 
click Save at the top of the window.

The evaluation form is now available for use.

Menu Bar
FILE

Select the category type and enter the category 
title. Click OK to save.

The new category is now created.

Highlight the new category and then click “Add” 
on the “Multiple Choice Entry” menu. 

Type the evaluation statement in the new multiple 
choice field. 
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SAVE REPORT

This option allows you to save all the information 
recorded in the log page as a text file. Clicking on 
it brings up the “Save As” dialog box:

Select the desired name and path, and click 
“Save”.

The shortcut key for saving a report is Ctrl + S. 
For a sample report, look at the figure below:

PRINT REPORT

This option allows you to print a text file 
containing all the information in the log for the 
latest session. Clicking on “Print Report” brings 
up the Print dialog box. The shortcut key for this 
option is Ctrl + P.

IMPORT

Use the “Import” menu to import palettes, 
scenarios, and modeling patients created on 
another PC or stored in a backup location.

To import an item into GIGA:

PROFILE

Click the Profile menu option to open the Profiles 
menu. To switch to a different profile, select the 
operating mode and the new profile and click 
“Load”.

NEW SESSION

Clicking New Session in the file menu will:

•  Clear any loaded/playing scenario

•  Clear any loaded/playing palette

•  Reset vital signs to normal values

•  Clear out log page

•  Restart the session clock. 

The session clock is located at the bottom of the 
dialog box.

The shortcut key for staring a new session is: Ctrl 
+ N

RESET SESSION CLOCK

Clicking on Reset Session Clock resets the 
clock back to zero. It does not have any effect 
on the transition time remaining on a scenario; it 
does not reset the vital signs, or clear out loaded 
scenarios. The facilitator can also reset the 
session clock by clicking on the Session button 
next to the session time.
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3.  Select the item to export from the list and click 
“Export”

The “Save As” window is displayed.

4.  Browse to the location where the file will be 
saved and click “Save”.

EXIT

Click File > Exit to close the GIGA software and 
turn the simulator off. Alternatively, click the 
power bottom and click the X icon near the top 
corner of the screen.

SETUP

1.  Click File>Import on the menu to access the 
“Open” menu. 

2.  Set the type of file to import.

3.  Browse to the location where the item is saved 
and click “Open” to import.

The scenario file is copied to the GIGA scenario 
library automatically.

EXPORT

Use the Export feature to backup palettes, 
scenarios (branched or linear), and model 
patients files.

To export an item and save it to a location on the 
computer:

1.  Click File > Export to open the “Export” menu 

2.  Select the file type from the “Export File Type” 
drop down menu:
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After making the Artificial Ventilation menu 
selection, this dialog box is displayed:

Click next to proceed with the calibration.

The software will now ask you to perform 
a number of “correct” artificial ventilations, 
depending on what you are calibrating.

The facilitator should follow the text cue on the 
screen to perform just ONE ventilation at a time, 
until prompted for the next one.

•  The wizard prompts you with a “#1”.

•  Perform one correct artificial ventilation.

CALIBRATION

This tool allows you to easily calibrate the sensors 
inside the simulator. First choose which function 
you would like to calibrate: chest compressions, 
artificial ventilations, or blood pressure cuff. The 
Simulator will not breathe or have chest rise 
during any calibration procedure.

The procedures for each specific calibrations are 
described in the sections below.

•  Chest compressions

•  Artificial Ventilations

•  Blood Pressure Cuff

If the simulator includes a compression 
sensor that determines the depth in inches/
cm, the calibration for chest compression 
will be disabled. 

ARTIFICIAL VENTILATIONS

This tool helps you calibrate the artificial 
ventilations to your specific criteria. That is, you 
will be telling the system what a correct artificial 
ventilation is. Providers will be evaluated by the 
system based on this criteria.
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4.  The wizard then prompts you with “20 mmHg”.

5.  Set the pressure on the BP cuff to 20 mmHg.

6.  Click the “OK” button.

7.  A green filled oval indicates the value was 
successfully set.

8.  Continue the process as instructed by the 
screens.

9.  Once the prompt reads “Done”, go back and 
calibrate another function or click the “Finish” 
button to close the calibration wizard.

FACTORY SETTINGS

Factory Settings is a very useful tool to consider 
when recalibrating. It restores the sensors to 
factory settings over-riding any calibrations 
performed by users.

Make sure that when you are restoring the sensors 
to the factory settings that no one is practicing 
chest compressions, ventilations, intubation or 
reading a blood pressure. Any of these actions 
may interfere with the reset. Each time that one 
of these sensors is clicked a message will appear 
at the bottom left of the screen notifying the user 
of the status of the reset (OK, or TRY AGAIN). 
Should the Sensor not respond, please refer to 
the troubleshooting guide or contact Customer 
Support.

At the end of calibrating a function, the Calibration 
Wizard resets the simulator for the changes to 
take effect and displays the message “Done”. If 
the wizard displays the message “Can’t reset”, it 
simply means that the new calibration values will 
take effect next time you start the software. If the 

•  A green filled oval indicates that the ventilation 
was successfully recorded.

•  The wizard prompts you with “#2”.

•  Perform a second correct artificial ventilation.

•  A green filled oval indicates that the ventilation 
was successfully recorded.

•  Continue the process as instructed by the 
screens.

At the end of the calibrating session, the wizard 
shows the average peak, depth, and duration 
values for the procedure. If you feel you performed 
the procedures correctly, click the “Save” button. 
Otherwise, press the “Back” button to repeat the 
calibration. Notice that you can go back, abort or 
cancel at any time during the procedure.

BLOOD PRESSURE CUFF

Blood pressure cuff calibration should be 
performed only when the Korotkoff sounds do not 
match the systolic and diastolic values set from 
the computer. 

1.  To calibrate, place the blood pressure cuff on 
the left arm.

2.  Select which arm you will like to calibrate.

3.  You will then be prompted to set the BP cuff 
to a certain pressure, hold that pressure 
constant, and press the “OK” button. Follow 
the text cue on the screen and repeat the 
procedure for each pressure level until “Done” 
is displayed.

For example, if calibrating the left arm:

1.  The wizard prompts you with “0 mmHg.”

2.  Set the pressure on the BP cuff to 0 (i.e. cuff 
valve open).

3.  Click the “OK” button.

A green filled oval indicates that the value was 
successfully set.
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GENERAL

This tab allows the facilitator to:

•  Enable auto saving of the log

•  Save your current log report

•  Enable stand-by warning

•  Select units (SI or English)

SIMULATOR ADD-ONS

Activation codes enable upgrade and additional 
software features.

Activation codes are unique to the simulator’s 
serial number. Before entering a code to activate 
a feature, go to the Environment tab, set the 
connectivity mode to FIXED, and enter the 
simulator’s serial number.

•  Simulator Virtual Monitor activation code

changes need to take immediate effect, simply 
close the GIGA software, wait about one minute 
(for the simulator to turn off), and then start GIGA 
again.

OPTIONS

Navigate through the Options menu to configure 
software settings and enable additional features.

ENVIRONMENT

The environment tab is used to configure the 
connectivity options. Select the “GENERIC” 
option to scan and connect to the nearest 
simulator. Alternatively, select the FIXED option 
and enter the simulator’s serial number to 
connect to a specific simulator only. The FIXED 
mode is required to enter activation code for 
upgrade features.
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•  Set average of ventilation PIP (peak inspiratory 
pressure)

TOLERANCES

Use the Tolerances to adjust the maximum 
cyanosis level.

LOG

Log event text entries are color-coded. Use the 
log tab to customize the color of each log entry 
type. Also, select or deselect “Log CPR” to have 
CPR recorded in the Log window.

OTHER

Checkmark “Details Apply: clear and close details 
window” to show the value of each palette’s vital 
signs parameter on the Details tab control fields.

Checkmark “Link respiration sensor to EKG 
leads sensors” to generate artifacts with each 
compression.

Checkmark “Use AV system other that Kb Port” 
to display the audio and video configuration 
menu on the menu tab.

Add-ons will vary according to each simulator

PACING/SHOCK

GIGA can detect small variations in the heart rate 
and current during pacing. Each variation could 
trigger a programmed auto response or create a 
new entry in the log event. Adjust the threshold 
for each parameter so only the changes greater 
than the ones specified will be detected by the 
GIGA software.

CPR OPTIONS

Configure the CPR trainer parameters to meet 
the most current CPR standards.

Use the controls in this window to adjust error 
margin allowed by the CPR intensity and rate:

•  Set the number of compressions per minute

•  Set number of ventilations per minute 

•  Set average of compression depth
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numerous walls or obstructions between the 
simulator and the control PC.

The USB RF module drivers must be installed 
on the virtual monitor PC before the “Remote 
Access via Network” feature can be configured. 

Go to www.Gaumard.com to download the latest 
USB RF module drivers using PC with internet 
access. Do not connect the Virtual Monitor PC to 
the internet. Transfer the USB RF module setup 
file to the virtual monitor PC using a USB drive 
and complete the installation.

To configure the “Remote Access via Network” 
connection:

1.  Connect the simulator’s USB RF module an 
available USB port on the virtual monitor PC

2.  Verify that both computers are connected to the 
ad-hoc network (e.g. GaumardNet,)

3.  Initialize GIGA on the tablet PC open the Remote 
Access via Network menu from the Setup 
menu

4.  Select the Remote access via network radio 
button

5.  Verify that Wireless Network Connection is 
selected from the adapter list

6.  Click “Find available” to auto configure the port 
used for this connection

7.  Write down the controller IP and port number, 
then click “Connect”

8.  Navigate to the V menu on the virtual monitor 
computer and select “Remote access Via 
Network”

Please wait 30 seconds for the feature to initialize

9.  Enter the “controller IP” and “port number” as 
shown on step 7 and click “connect”

AUTO RESPONSES

The Non-Scenario Automatic Response feature 
allows the facilitator to set preprogrammed 
responses to electrical therapy events. When the 
electrical therapy is detected, auto-responses 
can automatically load a specific palette 

Checkmark “Auto Osat Placement Feedback” to 
detect the placement of an O2Sat monitor on the 
left index. 

CODE BLUE III PULSES

•  Pulse Strength - Adjust the pulse strength 
control to fine tune the pulse intensity felt at a 
normal blood pressure.

REMOTE ACCESS VIA NETWORK

The “Remote Access via Network” feature 
allows GIGA to communicate with the simulator 
remotely using the virtual monitor PC as the 
RF transmitter. The alternate configuration may 
provide better connectivity in environments with 
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to program a specific palette item as an auto-
response.

Select the desired palette from the “Load Palette 
Item…” window and click “Load”.

The defibrillation shock auto-response is now 
configured apply the “Healthy Resting” palette 
if a virtual defibrillation shock of 200 Joules or 
greater is detected. The programmed response 
palette is listed in the “settings:” panel.

item or prompt the facilitator before making 
preprogrammed changes to the simulator’s vital 
signs.

Non-scenario response settings detect electrical 
therapy administered when a scenario is not in 
progress. For information on how to configure 
auto-responses for use during a scenario, go to 
Scenarios section. To activate the virtual shock 
panel for administering electrical therapy virtually, 
go to Menu>Options>General.

•  The behavior of each auto response option is 
explained below:

•  Off - The software does not respond to the 
electric therapy

•  Prompt - The software detects the electrical 
therapy and prompts the facilitator before 
applying the changes configured in the 
“Settings” section.

•  Auto - The software automatically detects 
the electrical therapy and compares it to 
a threshold selected by the provider. If the 
threshold is met, the vitals will automatically 
change to the parameters specified on the 
“Settings” section.

Each type of electrical therapy has a unique set 
of default parameters. For example, the default 
response to a defibrillation Shock applies the 
following vital sign parameter changes: NSR, 
75 bpm, BP 120/80. Click the palette button 
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to display the readings on the virtual monitor 
screen. To disable a parameter reading, click 
“OFF”. The vital signs monitor sensors defaults 
to “All On.” 

Some sensors, such as NIBP and Thermometer 
feature a STAT control that will allow the facilitator 
to activate readings on the virtual monitors from 
the controller software.

SENSOR CONTROL WINDOW

The sensor control window is a floating panel 
with on/off toggle controls. Click Monitors> 
Sensors> Window to open the floating sensor 
control panel. 

Move the slider to enable or disable the sensors 
displayed on the virtual monitor screen. The 
sensor will show up as ON or OFF. In the 
example above, all the sensors are on except the 
thermometer.

FILE SHARING

The file sharing menu allows the facilitator to 
send images, audio, and text files to the virtual 
monitor screen. Refer to “File Sharing” section 
above for more information.

AUTOMATIC MODE NON-SCENARIO 
AUTOMATIC RESPONSES

The “Automatic Mode non-scenario Automatic 
Responses” are unique to the automatic mode.

Link All Auto Response to Cardiac Irritability 
- Auto-responses will work only if the cardiac 
irritability option on the details page matches the 
selection on this window. 

An event prompt is displayed if electrical therapy 
is detected and the cardiac irritability set does not 
match the selection on the responses window. 

Drug Model Effect – Configure the auto-response 
behavior for drug administration.

•  Auto – Apply the drug effects based on 
medication’s programmed properties and 
dosage 

•  Prompt – Display a confirm prompt before 
applying the drug’s effects

The tallest bar represents the strongest channel. 

MONITORS

Use the Monitors drop down menu to enable/
disable sensors on the virtual monitor screen, 
share files, program custom scalars, and verify 
the connection between the GIGA and Gaumard 
Virtual Monitor software.

If the “Monitors” drop down is not showing, go to 
Setup>Options> Add-ons, and checkmark “Use 
Virtual Vital Signs Monitor.”

SENSORS

Use the sensors option to enable or disable any 
of the waveforms displayed in the vital signs 
monitor. Select the waveform and click “ON” 
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On the virtual monitor screen, click on a scalar’s 
menu and select “Close” to make the entry 
available for the custom parameter. 

The scalar entry is now a blank field.

Click on the empty scalar menu and select “Other” 
from the list of available scalar parameters. 
Select the name of the custom parameter.

The figure below shows two new values: Glucose 
level and hematocrit levels. Return to the custom 

CUSTOM NUMBERS

Use the custom numbers feature to add custom 
numerical parameters to the Gaumard Monitors 
screen. For example, glucose levels or platelets 
count. 

On the GIGA menu bar click Monitors>Custom 
Numbers to open the “Custom Numerical 
Parameters on Monitor” menu. Click the “Add” 
button to create a new parameter.

Type the name, minimum value, maximum value, 
initial value and units of the new parameter and 
then click “OK”.

The scalar parameter is now created. The user 
can either enter a value for the parameter and 
click “Update”, or modify the value from the 
STATUS/DETAILS control 
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DEFAULT INTERFACE LAYOUT OPTIONS

Change quickly between built-in interface layouts 
using the View>Interface Layout.

CLASSIC

Select the Classic option to revert the layout to 
the original state built in to GIGA.

SCENARIO EDITOR

The Scenario Editor includes panels and tabs 
necessary when building new scenarios.

CPR

The CPR layout allows the facilitator to monitor 
vital signs and the CPR trainer as the student 
performs exercises.

SAVE

Select “Save” to store the custom layout. Enter a 
description and click OK.

LOAD

Select Load to access and load any of the layouts 
previously saved.

SET AS DEFAULT

Use the “Set as default” option to automatically 
load the current interface layout upon startup. 

STATUS LAYOUT

The second layout option is used to modify and 
store the status/details panel elements. This 

parameter menu on the GIGA software to update 
the values when necessary.

CONFIGURATION

On the GIGA menu bar, click 
Monitors>Configuration to open the “Virtual 
Monitor Setup” window. Use the setup window to 
verify the connection between the GIGA software 
and the Gaumard Monitors vital signs software, 
re-configure the communication ports, and 
view the controller IP address. To troubleshoot 
connectivity issues between the two computers, 
please refer to the Appendix section.

VIEW

Modify GIGA’s modular interface design to 
accommodate specific simulations or exercises.

For example, a facilitator may prefer to just view 
certain detail windows, panels and tabs related to 
scenarios building in order to program scenarios 
efficiently. Outlined below are the options for 
customizing the GIGA layout.

INTERFACE LAYOUT

The interface layout refers to the size, position 
and type of panels and tabs in the GIGA 
environment.
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INSTRUCTION MANUAL

Click the Instruction Manual option to open a 
digital copy of the latest “User Guide” information.

ABOUT GIGA

Click “About GIGA” to view the software version.

CHECK FOR UPDATES

Redistributable GIGA installer files are available 
for download at http://www.gaumard.com/
software-updates/. 

To update the GIGA software using a flash drive:

1.  Download the update file to a flash drive using 
a computer with internet access

2.  Copy the setup file to the simulator’s control 
computer 

3.  Run the GIGA update file to update the software

Do not change the wireless network 
settings. Doing so will disconnect the 
virtual monitor computer and the Gaumard 
Monitors vital signs software.

To update the GIGA software using an Ethernet 
connection:

1.  Connect an Ethernet cable to the laptop PC.

2.  Click “Check for Updates”.

3.  Click “Install” to begin the update. The download 
progress bar begins to auto-fill as the setup 
file is downloaded

After the download is complete, the update setup 
wizard is launched automatically.

refers to the model view, detail window positions 
and parameters.

BASIC

Select the Basic option to view common detail 
window controls.

ALL

To view all the detail windows and parameters 
available, select ALL. If viewing all the controls, it 
is recommended to expand the size of the status/
details panel so the details windows can fit.

SAVE

Select Save to store the custom status layout. 
Enter a description and click OK.

LOAD
Select Load to access any of the status layouts 
previously saved.

SET AS DEFAULT

Use the “Set as default” option to automatically 
load the current status layout upon startup..

HELP
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4.  Click “Next”, and follow the wizard to complete 
the software download.

DIAGNOSTICS

The diagnostics menu is used to test the status 
of electronic and mechanical components in the 
simulator.

Click “Check all Modules” to run a full systems 
check. Active modules report blue. Modules that 
are inactive or not installed report black.
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Code Blue® III Adult 
Features
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Airway

NASAL AND ORAL INTUBATION

The Code Blue III Adult’s airway can be intubated 
orally using endotracheal tubes and nasally 
using a nasogastric tube or nasopharyngeal 
tube. The simulator also allows providers to 
use a LMA. In addition, anatomical landmarks 
on the simulator permit the completion of the 
Sellick’s maneuver.

Procedure Recommended  
Device Size

Intubation (Blade size) Miller 4 or MAC 
3.5

LMA Size 4 or 5

Nasal Intubation 8 mm outer 
diameter max

Oral Intubation ETT 7 or 7.5

Intubation and ventilation of the esophagus 
leads to visible gastric distension.

WARNING

The nasogastric intubation feature 
is used for placement and removal 
techniques. Fluids can be inserted 
through nasogastric tubes.

Ensure that the drainage tube (green 
port) is in place when large amounts of 
fluids are introduced

Always lubricate tubing prior to 
performing any nasal or oral intubation. 
Failure to do so will make intubation 
very difficult and is likely to result in 
damage.

Do not apply mineral oil directly into the 
mouth and airway. 

DRAINAGE TUBE

To connect the drainage tube, locate the green 
port situated on the right side of the simulator. 
Color match the draining tube to port.

INTUBATION SENSOR

Once intubated, sensors detect the depth of 
the intubation tube. If the tube is inserted too 
deep the left lung is disabled automatically, 
realistically demonstrating right mainstem 
intubation. Correcting the tube position enables 
the left lung.

AIRWAY SOUNDS

Code Blue III Adult can produce audible airway 
sounds. Use the software controls to change the 
sound type and adjust the volume. Auscultate 
using a standard stethoscope. 
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Breathing

BILATERAL CHEST RISE

Bilateral chest rise and fall is automatic. Use the 
software controls to adjust the breathing rate 
and the inspiratory percentage.

BREATHING PATTERNS

Control the respiratory rate, pattern, and 
inspiration percentage using the software 
controls. The breathing patterns are 
synchronized with the lung sounds and chest 
rise.

LUNG SOUNDS

Left and right lung sounds are available: normal, 
wheezing, inspiratory squeaks, and crackles. 
These sounds are synchronized with the 
breathing patterns.

VENTILATION

Practice BVM techniques using an adult sized 
mask having a thick seal. 

Ventilate via endotracheal tube with manual or 
mechanical ventilation.

Bilateral lung expansion is perceived with 
realistic chest rise.

Ventilations are measured and logged.

COMPRESSION

Realistic chest cavity allows students to 
experience the correct force needed to perform 
proper chest compressions.

Depth of chest compressions are measured and 
logged in cm or inches.

Proper chest compressions during CPR result 
in palpable carotid and femoral pulses. 

Cardiac

HEART SOUNDS

Code Blue III Adult is equipped with realistic 
heart sounds (normal, distant, systolic murmur, 
S3 and S4) which are tied to a user defined 
heart rate and selectable rhythms

ECG MONITORING

One of Code Blue III Adult most exciting features 
is the accommodation of real monitoring. In most 
cases, no special instruction is necessary to use 
such devices. The Adult’s conductive skin sites 
allow the attachment of real ECG electrodes. 
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This feature permits the user to track cardiac 
rhythms with their own equipment just like with 
a human patient.

INSTRUCTIONS FOR USE

1.  Turn on the simulator. Refer to the Equipment 
Set-Up section.

2.  Connect the ECG lead wires on the Adult’s 
ECG sites.

3.  Turn on the ECG monitor.

ELECTRICAL THERAPY

Defibrillation is only allowed on the large sternum 
and apex sites, circled GREEN below. NEVER 
deliver a shock to  ECG electrode targets on the 
shoulders or waist, marked RED below. Doing 
so will not create a fire hazard, nor is there risk 
of shock to the provider, but internal damage in 
Code Blue III Adult may result.  This situation is 
considered improper use and is NOT covered 
by the Code Blue III warranty.

There are inherent dangers in the use of 
some medical devices. For simulations that 
incorporate electrical therapy of any kind, 
always know your equipment, and follow the 
device manufacturers’ safety guidelines.

SNAP CONNECTORS

The chest skin snap connectors and “Snap 
Adapter Cable” allow providers to deliver 
electrical therapy at the sternum and apex sites 
without the use and frequent replacement of 
pads or patches.

Apex Snap



|  Code Blue® III Adult Features  |  User Guide  |  69

2.  Press down on the black clip and disconnect 
the chest skin (vest) from the ECG module 
(pacer).

3.  Connect the defibrillator snap harness to the 
chest skin and ECG module connectors

 

Notice that the defibrillator snap harness has 
two end-connectors labeled as “Pacer Snap” 
and “Vest Snap”.

The pacer snap connects the ECG module 
connector, and the vest snap connects to the 
chest skin connector.

Feature Maximum

Defibrillation 360 Jules

The snap sites provide the same electrical 
therapy functionality as the gold patches. 
This includes a detectable heart rhythm, 
cardioversion, pacing, and the detection of 
electrical therapy by the Gaumard software.

The snap connections are only functional when 
the internal “Defibrillation snap harness” is 
installed between the ECG module connector 
and the chest skin connector.

When the “Defibrillation snap harness” is 
connected, the chest skin sternum and apex 
gold patches are disabled.

The sternum and apex gold patches 
on Code Blue III Adult’s chest skin are 
connected as a standard.

To install the defibrillation snaps and enable 
snap sites follow the instructions:

To install the defibrillation snaps and enable 
snap sites follow the instructions:

1.  While the simulator is off, carefully unfasten 
the chest skin on the left side.

Sternum Snap

Vest Snap Pacer Snap

Chest Skin 
Connector

ECG Module 
Connector
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1.  Remove the snap connector covers at the 
apex and sternum sites.

2.  Connect the “Snap Adapter Cable” to the 
defibrillator.

3.  Connect the red snap connector to the apex 
connector.

4.  Connect the black snap connector to the 
sternum connector

WARNING

The snap adapter cables carry real 
energy. Handle the snap adapter cables 
with the same care and precautions 
used with real pads and patches and 
follow the same directions included with 
the defibrillator’s “directions for use” 
documentation.

Do not apply electrical therapy or 
deliver a shock while holding the snap 
connectors or while the snap connectors 
are disconnected from the simulator.

Only deliver electrical therapy when the 
simulator is fully assembled, dry, and 
undamaged.

Do not use damaged snap adapter 
cables, connectors, or medical 
equipment.

4.  Tuck the cables back into the cavity.

5.  Insert the skin’s placement pin into the 
guiding hole located on the Velcro®.

To re-enable the gold patches, disconnect the 
defibrillation snaps and re-connect the chest 
skin.

USING THE SNAP CONNECTORS 
(OPTIONAL)

 The “Snap Adapter Cable” connects to a real 
defibrillator and carries electrical therapy energy 
to the snap sites. The snaps are color coded to 
identify the apex and sternum placement.

Gaumard manufactures a variety of modified 
snap adapter cables compatible with most 
electrical therapy devices. For more information 
about snap cables for a particular defibrillator, 
please contact Gaumard.

Snap Cable Adapter Location

Red Connector Apex Snap

Black Connector Sternum Snap

To use the Snap Cable Adapter:
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CONNECTING THE MODIFIED CUFF

1.  Locate the Luer-Lock port on simulator’s 
left posterior shoulder and remove the cap 
enclosing the Luer-Lock port.

2.  Connect the Luer-Lock fitting on the end 
of the modified BP cuff extra branch to the 
Luer-Lock port on Adult’s left shoulder. Some 
facilitators prefer to make this connection 
before commencing a simulation session.

INFORMATION

Calibrate the BP cuff before measuring 
blood pressure. Refer to the “Working 
with GIGA” section for instructions.

INTRAVENOUS EXTREMITIES

The Code Blue III Adult is equipped with right 
IV training arm that can be used for bolus or 
intravenous infusions as well as drawing fluids.

Circulation

PALPABLE PULSES

The Code Blue III Adult is equipped with multiple 
automatic pulse sites that operate continuously. 
Pulses are located left (brachial and radial) and 
bilateral carotid and femoral pulses.

Pulses are synchronized with the ECG and 
dependent on blood pressure 

PROGRAMMABLE BLOOD PRESSURE

Programmable blood pressure can be read on the 
left arm using a modified sphygmomanometer. 
In addition, users can auscultate the Korotkoff 
sounds programmed by the software.
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collapse the veins. Disconnect the syringe tube 
from the port on the torso while maintaining 
suction. The port will seal, and the veins will 
remain collapsed.

For simulation of high volume infusions, it is 
necessary to leave the drain tube attached to 
the simulator. Place the distal end of the tube in 
a suitable outlet or container.

Systemic

INTRAMUSCULAR INJECTION SITES

IM sites on both deltoids and quadriceps for 
placement exercises.

WARNING

Do not inject fluids into the intramuscular 
sites.

INTRAOSSEOUS ACCESS

I/O access is used for the infusion of fluids, 
blood and/or drugs directly into the bone 
marrow of the tibia or other large bone. Setting 
up an intraosseous access line is an invasive 
procedure that can be simulated with the Code 
Blue III Adult.

WARNING

Do not attempt to fill IV system without 
the drain hose in place.

Always leave the drain hose connected 
when injecting fluids into the system.

Use only Gaumard’s provided simulated 
blood. Any other simulated blood brand 
containing sugar or any additive may 
cause blockage and/or interruption of 
the vasculature system.

FILLING THE VASCULATURE

1.  First, locate the fill syringe with tubing and 
the drain tube with pinch-clamp (included in 
your simulator packaging). Fill the syringe 
with the desired fluid - water or simulated 
blood.

The red ports, located on the right side of the 
simulator, are used for filling and draining the 
IV system.

2.  Connect the fill syringe to one port and the 
drain tube to the other port as shown.

3.  Leave the drain tube clamp opened and 
depress the syringe until all air has been 
purged from the IV system and fluid runs 
from the drain. 

To simulate a patient with no accessible 
peripheral IV sites, connect only the syringe. 
Pull the plunger to create suction, which will 
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5.  Re-attach the tibia cover.

6.  Palpate the tibial tuberosity.

 

7.  Insert the bone aspiration needle below the 
tibial tuberosity. Note the sharp decrease in 
needle resistance as it passes into the bone 
marrow cavity. Remove stylet, aspirate bone 
marrow, and infuse fluids.

WARNING

Always drain and flush the reservoirs 
after every simulation.

Cephalic

CENTRAL CYANOSIS

Activate central cyanosis and adjust the intensity 
using the GIGA application.

The following procedure describes how to use 
the I/O access feature:

1.  Remove tibia cover from the right leg to 
access the two part tibia.

2.  Gently remove both halves of bone, starting 
with the lower half 

3.  Fill the upper and lower half of tibia with fluid.

4.  Replace tibia bone in the leg.
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SPEECH

Code Blue III Adult  has over 80 pre-recorded 
expressions. The collection of speech and other 
sounds was chosen to cover a wide range of 
simulated emergencies. Use the GIGA software 
to activate speech.

VIRTUAL VITAL SIGNS MONITOR 
(OPTIONAL)

The Gaumard Virtual Vital Signs Monitor 
simulates vital sign monitoring equipment. 
The vital signs are synchronized through a 
wired connection between the facilitator’s 
laptop and an additional monitor. Each trace 
can be customized independently; users can 
set alarms, time scales, boundaries and grid 
options. In addition, it allows the facilitator to 
display lab reports, x-rays and other files on the 
Virtual Monitor screen for use by the provider. For 
information on how to setup Gaumard Monitors 
with GIGA, please refer to the Appendix.

Other

O2SAT MONITOR PLACEMENT 
DETECTION

The Code Blue III Adult can detect the placement 
of an O2Sat monitor on the left index finger. 
Once the O2Sat monitor is detected, the Virtual 
Vital Signs software will display the O2Sat value 
programmed by facilitator on the Gaumard User 
Interface. Please note that a reading will not be 
available on the O2Sat monitor itself.

INSTRUCTIONS FOR USE

1.  Start the Code Blue III Adult and wait until a 
connection is established.

2.  Turn on the oximeter monitor.

3.  Place the finger probe on the left index of the 
simulator.

The log will report when the O2Sat sensor is 
placed on the simulator.

4.  Set the O2sat value from the GIGA control 
panel and the vital signs monitor will display 
the chosen value.
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Appendix
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Anthony

Factory Preset Scenarios Flowcharts
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Bradycardia
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Pulseless Arrest
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More about 
Scenarios
TIPS ON CREATING SCENARIOS

THINKING IN TERMS OF PALETTE ITEMS

As described previously, palette items represent 
complete or partial groups of settings that have 
been stored as a single item. We learned how 
applying partial states will hold constant all 
settings that are left unspecified.

Not only does it take time to customize the 
palette, but a very large palette also becomes 
difficult to navigate. So, it is desirable to minimize 
the number of palette Items in each profile. To 
accomplish this, an experienced facilitator tries 
to create items that are as generally applicable 
as possible and can, thus, be applied to a wide 
range of scenarios. The key is to only include in 
your palette Items the settings that are directly 
related to the physiological event represented 
by that palette Item.

SMART SCENARIOS

After reading the Details, Palette, and Scenarios 
sections of this guide, it should be clear how to 
build a scenario. You may have already tried 
building your own or modifying some of the 
factory presets. The following four guidelines 
will refine your ability to build the best possible 
scenarios.

HOW WILL THE SCENARIO BEGIN?

The first thing to consider is the initial condition 
of the patient. Create a Palette Item to describe 
this condition. Make sure that this first step in 
the scenario is a complete state, indicate some 
selection for each and every available setting 
on the Details page. Remember that only the 
settings you specify will cause a change in Code 
Blue III Adult, and all other settings will remain 
constant. So, by starting with a complete state, 
Code Blue III Adult condition will always be the 
same when the scenario starts, regardless of 
what he was doing previously.

Likewise, the “transition duration” of the first 
step in the scenario should be zero, indicating 
that changes are applied immediately.

INCLUDE NOTES TO GUIDE THE 
FACILITATOR DURING THE SIMULATION.

It is common for scenario designers, especially 
those who act as facilitators, to neglect the 
importance of notes in the scenario. They think 
that they will remember the learning objectives, 
patient history, and other details at the time 
they are ready to conduct the simulation. They 
usually don’t, especially when revisiting a 
scenario months after creating it.

When you add “Wait” and “Wait Indefinitely” 
steps to a scenario, you have an opportunity to 
edit the item description. Use this description 
field to hold notes to the facilitator. Typically, 
scenario designers write notes in that space to 
indicate what the provider(s) or facilitator should 
be doing at that point.

Further, when saving the scenario, you may edit 
the scenario description. This is the best place 
to put patient history and any other longer notes 
and instructions.

ASSUME THAT PROVIDERS WILL DO THE 
RIGHT THING.

Usually, you should create a scenario with 
the assumption that the providers will perform 
correctly. As long as they do, the scenario can 
be allowed to continue.

Naturally, you must be prepared for what might 
happen to Code Blue III Adult when providers 
deviate from expectations. The consequences 
of such deviations can sometimes be included 
in the scenario, punctuated by “Wait Indefinitely” 
items. In other cases, the simulation will require 
more direct control by the facilitator via either 
the Palette or Details page. Ultimately you can 
use the branching scenario feature to make 
scenarios with more than one path.

CHOOSE AUTO-RESPONSE SETTINGS 
BASED ON THE SCENARIO CONTENT 
AND THE OBJECTIVES.

As you’ve seen, auto-responses can be used 
to free the facilitator’s attention. They also 
enhance realism by presenting instant reactions 
to the care providers. On the other hand, 
sometimes it is not possible or desirable to 
determine the responses before the simulation 
begins. Different environments and applications 
call for different settings.
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Some teaching practices are best done with 
the auto-response settings in Prompt mode. 
Responses must be triggered by a vigilant 
facilitator. Though it is slower and requires 
more attention, the benefit of Prompt over other 
modes is that the simulation can be allowed 
to go in any direction, and it will be possible to 
choose the response on a case-by-case basis.

Other learning exercises require a higher 
degree of automation. For such applications, 
most facilitators choose Auto mode for the 
auto-response settings. The key issue is 
standardized timing of symptom presentation. A 
consistent, repeatable simulation is essential for 
fair assessment of that care provider in relation 
to others and for the broader interpretation 
of results in the context of training validation 
studies.

When in doubt, it is best to choose Prompt 
mode, in which the facilitator will be given direct 
control of the responses as events are detected.

File Structure
Advanced users may find it helpful to understand 
the GIGA directory structure. With direct file 
manipulation, one can easily move palette items 
and scenarios between profiles, as well as move 
entire profiles from one computer to another.

PROFILES

In the GUI program folder is the “profiles” 
sub-folder (e.g. “C:\Program Files\Gaumard 
Scientific\Gaumard User Interface\profiles\”). All 
user information is saved there, and it is the only 
folder that should be modified manually. In the 
example shown, notice that there are 2 profiles 
in this installation, “Default Profile,” and “Quick 
Start Scenarios.”

PALETTE ITEMS

Saved as “*.plt” files, palette items in each 
profile are located at the top-level of each profile 
folder. To copy palette items from one profile to 
another, copy the .plt file found in the source 
profile folder.

SCENARIOS

Scenarios are stored as sub-folders within profile 
directories. Scenarios can also be transferred 
between profiles by copying the scenario folder 
and its contents.

WARNING

Do not modify files in the “resources” 
directory or those at the top-level of the 
“Gaumard User Interface” directory.

Do not manipulate files or folders while 
the GIGA software is running.

Do not modify or delete “*.dll,” “*.scn,” 
or “*.sys”.
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Troubleshooting
Use the following table to find causes and solutions to a number of possible problems.

Symptom Possible Cause Solution

"Communication 
module not 
found" message 
is displayed when 
GIGA is started

Communication module 
not connected

Connect the Communication module to laptop’s 
USB port.

Communication module 
not identified by the 
computer

Close the software and try disconnecting the 
Communication module for at least five seconds, 
then plug it back in and restart the software.

Chest 
compressions 
are not properly 
detected or not 
detected at all

Is the communication 
icon empty?

See solution above in section making reference to 
“Communication module not found”

Chest compressions 
are only detected when 
the respiratory rate is 
set to zero, otherwise 
they are ignored.

Set respiration rate to zero

Artificial 
ventilations are 
not properly 
detected or not 
detected at all

Is the communication 
icon empty?

See solution above in section making reference to 
“Communication module not found”

All others Calibrate artificial ventilation by going to 
Setup>Calibration

Pre-built 
scenarios don’t 
show up

Incorrect profile 
selected

Select “Quick Start Scenarios” when starting the 
software.

Should user forget to do so, there’s no need to shut 
down the software and open it again in order to load 
the pre-built scenarios. Go to “File/Profile” menu 
and then select “Modeled Scenarios

BP sound is 
absent or is not 
heard at desired 
volume level

Volume not set to 
user’s criterion

Every sound has a volume control. Play with the 
volume control to get it to the desired level.
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Diagnostics
The diagnostics tool is used to test the status 
of the modules that control the simulator’s 
features and functions. On the menu bar, click 
Help>Diagnostics to open the Diagnostics 
window.

This window is very useful for troubleshooting 
because it gives the user feedback on all of the 
working modules inside the simulator. 

To run a complete module test, click “Check All 
Modules”.

You can also check individual modules by 
clicking on the specific module you wish to 
check and then clicking on the “Check Single 
Module” button. The button will flash green 
when pressed.

Active modules report light blue, and inactive 
and not installed modules report black. If 
there is a specific module that fails to respond 
please contact Technical Support for advanced 
troubleshooting steps.

Connecting to the 
Gaumard Monitors
To connect the virtual monitor to the GIGA, you 
must have the laptop joined to the additional 
monitor, and you must properly the extended 
monitor. The section below describes in detail 
how to do both of these things.

ENABLING DUAL DISPLAY

The Code Blue III Adult system uses an 
extended screen to display the vital signs 
information. Enable the extended displays 
using the instructions below. Prior to configuring 
the extended displays, the monitor must be 
connected and powered on.

1.  Right-click the desktop, then click “Screen 
resolution”.

2.  From the “Display Properties” window, 
navigate to the Multiple displays drop-down 
menu.

3.  Select “Extend these displays” from the list 
and click “OK”.

4.  The Display Settings window prompts to 
accept the changes. Click “Keep changes” 
to continue.

The screens diagram will show that both 
screens are enabled.
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5.  Click “OK” to save changes.

CREATE AN EXTENDED MONITOR 
CONNECTION

Go to the “Code Blue III Adult Virtual Monitor 
Set Up” window by clicking on Monitors, 
Configuration on the GIGA.

6.  On this window, select the “Adapter” you will 
be using (Loopback (no network)).

The Virtual Signs Monitors should be configured 
to connect to the Controller IP designated by the 
selected Adapter (127.0.0.1). 

7.  Make sure the port numbers are the same 
for the laptop and the monitor displaying the 
Vital Signs and click on “Connect”.

Replacing Common 
Consumables
IV Arm Vein

WARNING

Vein tubing contains latex which may 
cause allergic reactions. Users allergic 
or sensitive to latex should avoid 
contact. Discontinue use of this product 
and seek medical attention if an allergic 
reaction occurs.

To replace the vein used in the lower right arm, 
follow the instructions listed below:

GATHER THE FOLLOWING ITEMS:

•  Replacement vein set

•  Mineral oil

•  Heat gun or blow dryer

•  Hemostat

REPLACING THE IV VEINS

1.  Attach the drainage tube to the red port 
located on the right side of the simulator, and 
purge the system.

2.  Gently heat the arm skin
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3.  Pull back the skin from the lower right arm 
and remove it completely.

4.  To replace the anterior veins of the arm, 
gently pull out the veins from each white 
connector as shown below.

5.  Remove both black rings on the tubes and 
place them on the replacement veins 

6.  Insert the replacement veins to each white 
connector, and secure the veins with the 
black rings.

7.  To replace the dorsal vein of the hand, gently 
pull out the vein from the white connectors.

8.  Once removed, attach one end of the 
replacement vein to one of white connectors 
as shown below.

9.  Feed this vein through the hole. You may use 
a hemostat to help you pull out the vein

10.  Attach the other end of vein to the second  
white connector, and secure both ends of the 
vein with the black rings.
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11.  Heat the skin.

12.  Apply small amounts of mineral oil on the 
lower arm to aid the skin placement.

13.  Place the skin over the hand and pull the 
skin all the way up.
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Warranty
EXCLUSIVE ONE-YEAR LIMITED WARRANTY

Gaumard warrants that if the accompanying Gaumard product proves to be defective in material or 
workmanship within one year from the date on which the product is shipped from Gaumard to the 
customer, Gaumard will, at Gaumard’s option, repair or replace the Gaumard product.

This limited warranty covers all defects in material and workmanship in the Gaumard product, except:

Damage resulting from accident, misuse, abuse, neglect, or unintended use of the Gaumard product;

Damage resulting from failure to properly maintain the Gaumard product in accordance with Gaumard 
product instructions, including failure to property clean the Gaumard product; and

Damage resulting from a repair or attempted repair of the Gaumard product by anyone other than 
Gaumard or a Gaumard representative.

This one-year limited warranty is the sole and exclusive warranty provided by Gaumard for 
the accompanying Gaumard product, and Gaumard hereby explicitly disclaims the implied 
warranties of merchantability, satisfactory quality, and fitness for a particular purpose.  Except 
for the limited obligations specifically set forth in this one-year limited warranty, Gaumard will not 
be liable for any direct, indirect, special, incidental, or consequential damages, whether based on 
contract, tort, or any other legal theory regardless of whether Gaumard has been advised of the 
possibilities of such damages.  Some jurisdictions do not allow disclaimers of implied warranties or the 
exclusion or limitation of consequential damages, so the above disclaimers and exclusions may not 
apply and the first purchaser may have other legal rights.

This limited warranty applies only to the first purchaser of the product and is not transferable.  
Any subsequent purchasers or users of the product acquire the product “as is” and this limited warranty 
does not apply.

This limited warranty applies only to the products manufactured and produced by Gaumard.  
This limited warranty does not apply to any products provided along with the Gaumard product that 
are manufactured by third parties.  For example, third-party products such as computers (desktop, 
laptop, tablet, or handheld) and monitors (standard or touch-screen) are not covered by this limited 
warranty.  Gaumard does not provide any warranty, express or implied, with respect to any third-party 
products.  Defects in third-party products are covered exclusively by the warranty, if any, provided by 
the third-party.

Any waiver or amendment of this warranty must be in writing and signed by an officer of Gaumard.

In the event of a perceived defect in material or workmanship of the Gaumard product, the first 
purchaser must:

Contact Gaumard and request authorization to return the Gaumard product.  Do NOT return the 
Gaumard product to Gaumard without prior authorization.

Upon receiving authorization from Gaumard, send the Gaumard product along with copies of (1) the 
original bill of sale or receipt and (2) this limited warranty document to Gaumard at 14700 SW 136 
Street, Miami, FL, 33196-5691 USA.

If the necessary repairs to the Gaumard product are covered by this limited warranty, then the first 
purchaser will pay only the incidental expenses associated with the repair, including any shipping, 
handling, and related costs for sending the product to Gaumard and for sending the product back 
to the first purchaser.  However, if the repairs are not covered by this limited warranty, then the first 
purchaser will be liable for all repair costs in addition to costs of shipping and handling.

Extended Warranty In addition to the standard one year of coverage, the following support plans are 
available: Two-Year Extension (covers second and third years)

Call for pricing (USA only)



Contact Us
E-mail Technical Support: support@gaumard.com

Before contacting Tech Support you must:

1. Have the simulator’s Serial Number

2. Be next to the simulator if troubleshooting is needed.

E-mail Sales and Customer Service: sales@gaumard.com

Phone: Toll-free in the USA: (800) 882-6655

Worldwide: 01 (305) 971-3790

Fax: (305) 667-6085

Post: Gaumard Scientific

14700 SW 136 Street

Miami, FL 33196-5691

USA

Office hours: Monday-Friday, 8:30am - 4:30pm EST (GMT-5, -4 Summer Time)

General Information

Gaumard®, ZOE®, Michelle®, Mike®, PEDI®, Susie Simon®, Susie®, Simon® Code Blue®, SIMA 
Models®, SIMA GYN/AID®, Virtual Instruments®, Codemaker®, Code Blue®, NOELLE®, Simulation 
Made Easy™, HAL®, CPRLink™, Zack™, RITA™, Chloe™, Seatbelt Susie™, Krash Kids™, Premie™, 
GIGA®, Omni®, SmartSkin™ are Trademarks of 

© Gaumard Scientific Company, 2013
All rights reserved.
Gaumard®, NOELLE®, HAL® are trademarks of Gaumard Scientific Company, Inc.
Patented; Other Patents Pending
Always dispose of this product and its components in compliance with local laws and regulations.

®Gaumard
Simulators for Health Care Education


	Bookmark 143
	Bookmark 144
	Bookmark 145
	Bookmark 146
	Bookmark 147
	Bookmark 148
	End User License Agreement
	Care and Cautions
	Overall Warnings
	General
	Operating Conditions
	Storage Conditions
	Procedures
	Cleaning
	Electrical Therapy
	ECG and Electrical Therapy Checklist and Warnings


	Getting Started
	Overview
	Airway
	Appearance 
	Breathing
	Circulation
	Simulator
	Other
	Included Accessories

	Terminology
	Facilitator
	GIGA™
	Palette Item
	Profile
	Provider
	Scenario
	Scenario Item 


	Equipment Set Up
	Simulator Set Up
	Simulator Placement
	Leg Assembly
	Battery

	Computer Set Up
	Control Computer
	Communication Module
	Extended Screen Virtual Monitor (Optional)
	Control Tablet PC (Optional)
	All-in one Touch Virtual Monitor PC (Optional)
	Wireless Communication Module (Optional)


	Working with GIGA™
	Initializing the Simulator
	Profiles And Operating Modes
	Creating A New Profile 

	GIGA™ Interface
	Connection Status
	Session Clock
	Power/Stand-By Button
	Status/Details Controls

	Virtual monitor
	Waveform Menu
	Changing Vital Signs
	Noninvasive Blood Pressure

	File Sharing
	File Sharing

	Palettes
	Lineal Scenarios
	Linear Scenario Overview
	Scenario Controls
	Scenario Quick Launch
	Creating New Lineal Scenario
	Additional Scenario Features

	Branching Scenarios
	Branching Scenario Screen
	Creating A New Branching Scenario

	Labs
	Preparing A Lab Report
	Send To Monitor
	Creating A Lab Template

	Speech
	Prerecorded Sounds

	CPR
	Testing
	Coach
	Report

	Shock/Pace Panel
	Provider Actions
	Session Information
	Team Logging
	Tracking Provider Actions
	Creating New Provider Action Buttons

	Event Log
	Adding Notes
	Creating A New Session Log
	Saving The Log Information

	Evaluation Form
	Using Built-In Evaluation Form Templates
	Printing An Evaluation
	Creating New Evaluation Templates

	Menu Bar
	File
	Setup
	Monitors
	View
	Help


	Code Blue® III Adult Features
	Airway
	Nasal and oral Intubation
	Intubation Sensor
	Airway Sounds

	Breathing
	Bilateral Chest Rise
	Breathing Patterns
	Lung Sounds
	Ventilation
	Compression

	Cardiac
	Heart Sounds
	ECG Monitoring
	Electrical Therapy

	Circulation
	Palpable Pulses
	Programmable Blood Pressure
	Intravenous Extremities

	Systemic
	Intramuscular Injection Sites
	Intraosseous Access

	Cephalic
	Central Cyanosis

	Other
	O2SAT Monitor Placement Detection
	Speech
	Virtual Vital Signs Monitor (Optional)


	Appendix
	Factory Preset Scenarios Flowcharts
	More about Scenarios
	Tips on Creating Scenarios
	Smart Scenarios

	File Structure
	Profiles
	Palette Items
	Scenarios

	Troubleshooting
	Diagnostics
	Connecting to the Gaumard Monitors
	Enabling Dual Display
	Create an Extended Monitor Connection

	Replacing Common Consumables
	Gather the following items:
	Replacing the IV veins

	Warranty
	Exclusive One-Year Limited Warranty



